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Edelbrock QwikData 2

Introducing QwikData 2

Thank you for acquiring QwikData 2. You now have at your fingertips all the tools you'll need to manage your

Data  Acquisition  applications!  QwikData  2,  and  the  individual  development  tools  within  QwikData  2  contain

many features that make Data Acquisition a breeze.

Edelbrock's  new QwikData 2 is a complete data acquisition system designed for a wide verity of motorsports.

The system consist of a data logger unit,  PC based software and various sensors.  The system includes two

built  in  accelerometers  to  measure  longitudinal  and  lateral  acceleration,  battery  voltage,  LCU  internal

temperature and up to 30 external inputs.

The QwikData 2's new software package offers the user a simple interface to access more data and feedback

than  ever  before.  Data  downloads  and  transfer  rates  have  also  been  improved  with  the  addition  of  a  USB

connection. All the components inside the LCU are surface mounted to provide shock and vibration resistance

along with  reduced electrical  noise and  RFI  interference.  QwikData  2  is  available  in  two versions;  the Basic

System comes equipped with 8 analog inputs, 4 thermistor type temperature sensor inputs, 2 digital inputs, a

Tach  Input,  and  1  switched  output.  The  Advanced  Thermocouple  System  comes  equipped  with  12  analog

inputs, 8 K type EGT sensor inputs, 4 thermistor type temperature sensor inputs, 5 digital inputs, a Tach Input

and 2 switched outputs. A Advanced Analog Harness (all  analog inputs)  is  available  as an alternative to the

Advance Thermocouple Harness. Paired with the Basic Harness the Advanced Analog Harness provides  20

analog  inputs,  4  thermistor  type  temperature  sensor  inputs,  4  digital  inputs,  a  Tach  Input  and  2  switched

outputs. The digital inputs can record on -  off  events and frequency (such as mph, rpm, and digital  fuel  flow

sensors).

 QwikData 2 is compatible with first generation QwikData sensors.

A  logging  table  window  enables  the  user  to  select  channels  for  logging  and  set  individual  channel  sample

rates. Data sample rates are adjustable per channel from 1 to 1000 samples per second.

If  you  have any  questions  or  issues with  QwikData  2,  you  can  contact  our  QwikData  2  Technical  Hotline  at

800-416-8628 from 7:00 am to 5:00 pm PST Monday thru Friday. 

Edelbrock  customers  can  now  join  others  at  http://forums.edelbrock.com/forums/  The  forum  offers  support

from current experienced users as well as Edelbrock Tech Reps.

http://forums.edelbrock.com/forums/
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We have worked to make this documentation easy to use, beginning with these links to places you can use as

first stops in your search for information. 

· Using  the  table  of  contents,  follow  the  underlined  topics  through  out  this  manual  to

detailed information regarding current subjects.

· Getting Started - Details regarding Help files, Bill  of Materials,  basic Personal  Computer requirements and

some examples of QwikData 2 systems to help better familiarize yourself with the power and capabilities of

QwikData 2.

· System Installation  -  The  topics  in  this  chapter  are  included  to  help  simplify  your  data  acquisition  system

installation.

· Harness   Details  -  Harness  schematics,  pin  out  designations  and  connector  details  for  each  system  are

available in this section.

· Configuration - Data logger, channel setup and calibration editor. 

· Data Analysis- Data analysis, graphing, and custom reports application. 

· USB Communication- Data logger monitor, download and configuration program. 

· Typical QwikData 2 System Examples - See these examples of QwikData 2 Data Acquisition system.

· Pre Outing Check-List - This checklist may be useful for insuring a complete vehicle setup prior to a outing. 
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Finding Information

This page covers how to access all topics from the product documentation installed on your computer.

Product  documentation  can  be  located  on  the  toolbar  of  your  QwikData  2  software  application  by  selecting

Help and provides the following information:

· Access to the entire Table of Contents from your computer. 

· Full-Text Search to look up topics. 

The help documentation highlights the top features of each application and points to more in depth information.

Using Help

This page contains information about how to navigate and search through the many help topics that will assist

you in getting started with QwikData 2.

To find more information, you can:

· Double-click one of the Help books on the left, then click a topic. 

· Click the Index tab and enter a keyword. 

· Click the Search tab and enter a phrase. 

When working with this window, you can:

· Click Help Topics to show or hide the Contents panel on the left. 

· Make the Contents panel bigger or smaller: click and drag the divider bar. 

· Make this window bigger or smaller: click and drag the bottom left or right corner of this window. 

When  working  from  a  hard  copy  of  the  installation  instructions  use  the  Table  of  contents  to  locate  more

detailed information regarding underlined topics.
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Getting Started

The following is a guideline for configuring your logger. Details regarding the underlined topics are outlined in

the following pages of this manual. 

· Before loading software review the topics  USB Drivers and System Requirements.

· For information regarding harness and LCU installation in your vehicle, 12 volt power connections and logger

activation switch refer to System Installation.

· Review the Instrumentation and Harness  Details section for information pertaining to connector location and

pin out designations your system level.

The QwikData 2 data acquisition system is broken down into three parts:

· Configuration - Data logger, channel setup and calibration editor. 

· Data Analysis - Data analysis, graphing, and custom reports application. 

· USB Communication - Data logger monitor, download and configuration program.

After you have loaded your software Icons for each of the application will be placed on your desktop.

CONFIGURATION - 

DATA ANALYSIS - 

DATA COMMUNICATION - 

· Double click on any Icon to open the application.

NOTE:  Many  items  in  the  Software  Toolbars  will  be  grayed  out,  these  are  reserved  for  functions  in

future software releases.
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System Requirements

The system requirements for QwikData 2 are as follows:

· Pentium personal computer with 1GHz or higher processor. 

· Microsoft Windows 2000 or later (Vista 64 not supported).. 

· 256 MB of RAM (512 MB recommended) for Windows XP. 

Hard disk space required for installation:

· Power to Win (50 MB Typical, 94 MB Maximum) 

Additional system requirements:

· CD-ROM drive. 

· VGA or higher-resolution monitor (Super VGA recommended). 

· Microsoft Mouse or compatible pointing device. 

· Universal Serial Bus (USB port). 

· Microsoft Office Excel

Software Installation

This section contains information on installing QwikData 2 to your computer. It is recommended that you check

the section on System Requirements before installing this product.

NOTE: Some files and components of QwikData 2 installation are referred to as Power To Win and EFI.

1) Insert the QwikData 2 software installation CD in your computers CD ROM Drive.

2) Select Install Edelbrock QwikData 2. 

3) Setup will open and guide you thru the install procedure.

4) Do not change the default installation drive or path. 

5) Click next to confirm installation.

6) When installation is finished "Installation complete" will display,

   Select "Close" to exit.

*QwikData 2 Software installation is complete, three shortcut Icons for USB Comms, Config and Analysis have

been placed on your desktop.

Notes: Included in the installation is a SAMPLE.DAT logger data file located at Power to Win\Data to help you

familiarize yourself with the many features of QwikData 2.
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USB Drivers

The  QwikData  2  Power  to  Win  install  disk  will  copy  the  current  device  drivers  during  installation  to  your

"C:\Power to Win" directory. Follow the instructions below to complete the installation of your USB drivers. 

NOTE: Some files and components of QwikData 2 installation are referred to as Power To Win and EFI.

First Time Installation

USB Driver Initialization: Power up your  Logger and connect  to your  Laptop with  the USB cable.  When

connected the logger hardware will be detected and the "Found New Hardware" wizard will  open. Follow the

instructions to install the driver making sure to point to the "C:\Power to Win" directory if prompted.

1. From Hardware Update Wizard window select Install from a specific location. Select Next to continue.

2. Enter Path: C:\Power To Win or select from pull down in window. Select Next to continue. Update wizard

will locate and setup necessary driver device.

Notes

· Drivers can only be installed or updated when the logger is powered up and connected to the USB port. 
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To Update Drivers

Power up your Logger and connect to your Laptop with the USB cable.

1. Click Start and select the Control Panel icon. 

2.  Select the System Icon. 

3. Press the Hardware tab and select Device Manager. 

4. Under the Universal serial Bus controllers list locate the existing EFI Logger device. 

If the EFI Logger does not appear in the device list check that the logger is powered up and connected to the

USB port. When running under Win XP some peripheral USB devices are known to corrupt older versions of

the EFI Logger device driver and it may be necessary to uninstall the previous version before proceeding.

5. Right click and select Update Driver 

6. Follow the instructions to install the new device driver. 

Notes

· Drivers can only be installed or updated when the logger is powered up and connected to the USB port. 

· If your computer is connected to a network, network policy settings might also prevent 

you from completing this procedure. 

Performance Tips

Listed below are some ways to help improve the overall performance of this product on your computer.

· Turn off virus checking on Analysis.exe

· De fragment your hard drive after installing the product. 

· Check the recommended RAM and processor requirements for this program, and consider upgrading your

memory or disk speed. 
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File Types

The following table is a list of the installed file types, paths and descriptions.

Name Where Comments

Analysis.exe C:\Power to Win logger data analysis application

Config.exe C:\Power to Win logger configuration application

Usbcoms.exe C:\Power to Win logger communication application

Settings.nsb C:\Power to Win default usb screen setup file

PowerTW.chm C:\Power to Win power to win help file

*.stp C:\Power to Win\Libs exported logger setup files

*.lib C:\Power to Win\Libs user defined setup library files

Excel.rpt C:\Power to Win\Reports user defined data analysis report files

Report.xls C:\Power to Win\Reports report template file

Sample.dat C:\Power to Win\Data sample logger data file

Channel.dsc C:\Power to Win\Setup logger channel descriptor file

@LCU1.cal C:\Power to Win\Setup logger car(1) setup file

ECU.cal C:\Power to Win\Setup ecu logger channel calibrations

001.mdf C:\Power to Win\Setup comms control screen setup file

Mathchl.def C:\Power to Win\Setup logger math channel definition file

Constant.def C:\Power to Win\Setup logger math constant definition file
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System Installation

Once you have chosen the devices and accessories you need for your application, they need to be installed in

the vehicle and properly wired. 

The following topics in this chapter are included to help simplify your data acquisition system installation.

LCU Installation

When installing the LCU you should consider the following points:

· The  LCU  is  resistant  to  water,  oil  and  fuel,  but  after  prolonged  exposure  to  these  elements  they  may

eventually work their way inside the LCU.

· Select a mounting position where the LCU will not be in constant contact with any fluid.

· Make sure that air can flow over the LCU to keep it below +70ºC

· Do  not  place  the  LCU  near  source  of  electrical  interference  e.g.  ignition  boxes,  coils,  plug  leads,  or

alternators.

· Mount the LCU bracket to the vehicle, line the bracket with the supplied foam tape, secure the LCU in the

bracket with supplied O-Ring. Note: If G-Load data is desirable, for Lateral and Longitudinal sensor data to

read properly the LCU must be mounted in a specific orientation. It is advisable to mount the LCU parallel to

the ground with the QwikData 2 label up and the harness connectors facing forward.
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Harness Installation

To  provide  a  splash-proof  system  and  make  installation  as  easy  as  possible,  QwikData  2  uses  high-grade

water  resistant  connectors  and  an  external  wiring  harness.  To  connect  the  harness  to  the  LCU  push  the

connectors directly into the LCU until you hear a "click". To remove the harness grasp the harness connector

securely while depressing the two tabs located on the top and bottom of the connector and pull away from the

LCU.  The  wiring  harness   is  assembled  with  connectors  that  mate  to  the  supplied  sensors.  Each  sensor  is

connected to the QwikData 2 unit by simply mating the appropriate connectors.

Route the wiring harness as needed to make connections to the installed sensors. Avoid paralleling Data Log

wires with any ignition wiring (primary or secondary). To connect the circular connectors on the wiring harness

to the sensors, push the mating connectors firmly together and then turn the locking ring clockwise to lock the

connectors together.

Refer to the Harness  Details section for assistance with routing you harness.

Notes:

· Allow harnesses to follow their natural curvature. Do not force them around very tight radiuses.

· When a harness passes through a hole in the chassis or firewall, make sure that there is no risk of it being

cut or damaged and is not routed near distributor or ignition secondary wires.

· When using tie-wraps avoid attaching harness to sharp or abrasive objects.

System Power Requirements

The LCU needs a switched supply voltage greater than 10.0 volts to power-up and between 9.0 volts and 18.0

volts to operate correctly.  If  the supply voltage is outside the 9.0 volts  and 18.0 volts  limits,  the LCU will  not

function properly.

Power is connected to the QwikData2 using the Pink/Black (switched12 volts) and Black (ground) wires on the

wiring harness. Connect the Pink/Black wire to a switched 12Volt source (e.g. output of ignition switch) and the

black wire to a good ground source. Do not connect the Pink/Black wire directly to the battery, as this will put a

constant  current  draw  on  your  battery  when  the  logger  is  not  in  use.  QwikData  2  does  not  need  continual

battery power to preserve data and configuration settings.

Avoiding RFI and EMI Interference:

When installing the QwikData2 data logger unit avoid RF and EMI interference and make sure all grounds are

connected  to  a  clean reliable  ground source.  Try  to  keep  all  data  logger  unit  wiring  as  far  as  possible  from

ignition components and related wiring. Avoid paralleling data logger wires with any ignition wiring(primary or

secondary). Do not mount the data logger unit next to ignition box or ignition components.
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Data Logging On/Off Switch

With the QwikData 2 system, data logging can be started and stopped either automatically based on sensor

values or manually with a switch(default configuration). If manual-logging is desired, a single pole on/off toggle

switch must be installed in the vehicle and connected to the two logging control wires labeled "LOG SW" in the

main harness. One wire should be connected to each terminal of the toggle switch. Data logging will start when

the toggle switch is turned on (closing the circuit between the two wires) and stops when the switch is turned

off. If the automatic data logging is configured the switch is not needed.

To enable manual log switch see Logging Table Enable Conditions in the Configuration section.

Logger Unit

Internal Channels

The  LCU has four internal channels which can be monitored and logged in the same manner as the external

analog or  digital  inputs.  The battery  voltage and box temps should  be logged to keep track  of  the operating

conditions of the LCU at all times.

The available internal channels are listed in the table below.

Channel Description Channel I.D

Battery LCU internal battery (volts) 0000

Box Temp LCU internal case temp. (deg C) 0002

Longitudinal G Longitudinal acceleration (G) 0001

Lateral  G     Lateral acceleration (G) 0003

Digital Inputs

Digital  channels  (also  referred  to  as  Frequency)  can  be  used  to  measure  RPM,  Speed,  Frequency,  Pulse

Counts  and  Digital  Events.  The  QwikData  2  Basic  System  has  1  Tach  Input  and  1  digital  input.  Harness

connectors are labeled Tach Input and Freq. 2. The QwikData 2 Advanced system has 4 digital channel inputs.

Harness connectors are labeled Tach Input, Freq. 2, 3, and 4. The Tach Input and Digital Inputs 2 thru 4 are hi

speed digital input channels. Digital #5 - Pin 15 of the 34 pin Basic LCU connector and Digital #6 - pin 26 of the

Advanced 26 pin connector can be wired to as low resolution digital inputs. This input acts as a counter each

time a digital event occurs (the counter resets to zero each time the logger power is cycled). For information

regarding Tach Input or Digital Speed Sensor connections to a digital channel refer to examples Connecting a

Tach Input, Connecting a Digital Speed Sensor.
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Data Logger Options

The QwikData 2 Data Logger is capable of logging 24 analog and 6 digital  channel  inputs.  12 of  the analog

channels are analog only inputs.  Analog channels 7 thru 10 and 17 thru 24 can be configured for thermistor

type temperature sensor inputs or K type EGT thermocouple inputs. EGT K type and thermistor inputs require

additional temperature adapter card. Adapter cards are available in different configurations. QwikData 2 Basic

comes standard with 4 channel thermistor card.(no EGT inputs) 

The main board inside the QwikData 2 enclosure holds two sets of D.I P. switches.  The set of 4 D.I.P switches

configure  channels  7  thru  10,  the  set  of  8  D.I  P  switches  configure  channels  17  thru  24.  ON  representing

standard Analog channels configuration, OFF representing temperature adapter card configuration. If adapter

card  is  installed  D.I.P  switches  must  be  properly  set  for  channels  to  function  properly.  Only  switches

representing channels available on Adapter Card should be enabled. See literature included with Adapter Card

for  proper  D.I.P  settings.  The  Advanced  logger  comes  configured  for  4  thermistor  and  8  EGT  channels

(temperature  adapter  card  included).  Two  QwikData  2  Advanced  harness  configurations  are  available.  

QwikData  2  Advanced  Thermocouple  Harness  #91294  is  available  for  8  thermocouple  4  thermistor

configuration or QwikData 2 Advanced Analog Harness  #91291 for all Analog or Analog / Thermistor inputs.

(temperature adapter card #91169 only necessary if 4 thermistor inputs desired.

Temperature Adapter Card Installation

Different configuration Temperature Adapter Cards are available.

Installing Temperature Adapter Card is a simple procedure, all that is required is a clean bench covered with a

soft surface, and a phillips screw driver.

1) Remove the LCU from the vehicle and wipe case clean.

2)  Place LCU on clean soft  surface and remove 4 phillips  head screws from end  plate  on connector  end  of

case. Do not remove phillips head screw located just above USB comms port.

3) Hold main body of case with one hand and slowly slide end plate with connectors and board outward with

other hand until entire board is removed. Some pressure may be necessary to break loose silicone sealant.

4) Position assembly on flat soft surface with analog board facing up.



16

Getting Started

Edelbrock QwikData 2

        

5)  D.I.P switches are now exposed.  Switches are  small  and  delicate,  positions  are  very  easily  adjusted  with

paper clip or small pointed device. The set of 4 D.I.P switches configure channels 7 thru 10, the set of 8 D.I P

switches  configure  channels  17  thru  24.  ON  representing  standard  Analog  channels  configuration,  OFF

representing  temperature  adapter  card  configuration.  If  adapter  card  is  installed  D.I.P  switches  must  be

properly  set  for  channels  to  function  properly.  Only  switches  representing  channels  available  on

Adapter Card should be OFF. See literature included with Adapter Card for proper D.I.P settings.

6)  Install  analog board. Analog board is supplied with two mounting legs. Install  legs into  main circuit  board.

Support analog board on ends near mounting legs, align legs with holes in board and pins to socket connector.

Apply lite pressure to analog board until board is fully seated on legs and tangs are exposed.

7) Apply a thin bead of silicone to case end to help seal cover when fastened.

8) Slip board assembly back into case, be sure main board is supported in slots on either side inside case. Re

install phillips head screws.
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Configuration

Open the Configuration program by double clicking the Configuration Icon  on your desktop.

The Configuration module is an advanced, yet intuitive development tool for managing all of your data logger

setups. It features a file folder window to facilitate easy management and viewing of your setup files and their

associated functions.

Setup files contain a Channel Logging Table, Outing Information, Channel Data and Channel Calibrations for

up to 10 different cars.

A variety of tools are provided for setting up your data logger. Different setups can be created for each defined

car  to  allow  for  differences  in  sensor  packages  and  vehicle  configurations.  The  setup  screens  have  been

designed to list the various logger functions into related groups for ease of use.

The Logging Table organizes the selected channels for logging, sample rates and logger start stop criteria's.

The Register LCU function organizes  setup files and logged data download paths for specific LCU's by serial

number.  This  allows  the  computer  to  access  the  appropriate  setup(CAR  ##)  and  calibration  files  and

distinguishes which LCU is being connected and sends the logged data to the preset download path.

The Channel Calibration editor CTRL+C simplifies creating and editing sensor calibrations.

A QwikData 2 Sensor Calibration Library is provided in the Calibration Editor Window containing calibrations

for  all  QwikData  2  sensors.  Just  choose  a  sensor  by  part  number  and  apply  the  calibration  to  the  selected

channel using the Import Calibration function.

Using the copy/save calibrations functions allow user libraries to be created to back-up your  different  setups

and calibrations. 
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File

Add New Car

Use  this  function  to  create  multiple  car  setups.(Car  ##).  Highlite  the  existing  setup  to  use  as  a  template  or

choose import from a previously saved setup.

1. On the Menu Bar under File select Add New Car. 

        

2. Select a template from one of the existing car setups. For initial setup highlight  Setup #001.

3. Press OK to create a new car setup. 

The new car will be created and automatically be added to the next empty position in the setup folder.

Notes

· Use the Import button to select from a list of saved setup (*.STP) files. 

· Up to ten different setups can be created.
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Set Current Car

Set Current Car opens a specific Setup file for editing.

1. On the Menu Bar under File select Set Current Car. 

     

2. Highlite a setup in the current car window for editing. 

3. Press OK.

Notes:

· Before the new Setup can be loaded in the LCU you must  Register  the LCU and Download Path with  the

new Car Setup # in Register LCU.

· You can also change the current car by using drop down combo box at the top of the setup folder. 
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Register LCU

In order for the LCU to recognize a specific setup file (CAR ##), the LCU serial number must be registered and

a  download  path  must  be  specified  for  LCU  logger  data  that  will  be  downloaded  automatically  to  this  user

defined location on your computer. The serial number can be found on a sticker on the housing of the LCU and

also appears on the status bar of the USB Comms screen of your computer when connected.

1. On the Menu Bar under File, click Register LCU's. 

2. Enter the LCU serial number and logger download path next to the Car setup you are working with. 

3. You can browse for a download path by clicking the [...] button. 

Select  the new path or  enter  the name in  the path  text  box.  If  the  download path  does  not  exist  you  will  be

prompted to have it created for you.

4. Click OK to save changes. 

Notes

· Create  recognizable  file  names  like  Car  description  or  event  name  eg:C:\Power  to  Win\Data\Mustang  or

C:\Power to Win\Data\Raceway Park

· Unused serial number fields should be set to zero. 

· Data downloaded from an unregistered LCU will default to position one. 
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Logger

The data recorded into the QwikData 2 Logger is downloaded to a PC, either each time the vehicle comes into

the pits or at the end of a race, or test session.

A  logging  table  window  enables  the  user  to  select  channels  for  logging  and  set  individual  channel  sample

rates. Data sample rates are adjustable per channel from 1 to 1000 samples per second. The logger frequency

rate that a channel is sampled should depend on the channel parameter being measured. For example, engine

coolant temperature changes slowly so it can be logged slow at 1Hz (1 time a second), whereas engine RPM

or wheel speed changes very quickly and needs to be logged faster at 20–50 Hz (20–50 times per second). If

the coolant temperature is logged at 20 Hz it will waste logging memory; and if RPM is logged at only 1 Hz it

will not be useful as a lot of detail is missing. The current log time available and logger memory is displayed on

the right in the logger table. Available log time adjust as sample rate are adjusted and channels are selected.

QwikData 2 Basic comes equipped with 1 Meg of memory. QwikData 2 Advanced comes equipped with 4 Meg

of memory.
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Logging Table Enable Conditions

Use this function to setup the enable conditions that define the logging start and stop criteria. Logging will start

when either of the start conditions are met but will only stop when both stop conditions are met.

Your QwikData 2 harness is supplied with two leads labeled LOG-SW and SW-GND for a switch to manually

start logging(Switch in closed position) and stop logging. Select Switch 3 for manual switch override. The Start

Stop Conditions have no effect when the Switch 3 is active.

1. On the menu bar under Logger, click Logging Table. 

2. Click on the Enable tab. 

3. Set the Start logging conditions or select Switch 3 for manual logging switch. 

4. Set the Stop logging conditions 

5. Click OK to accept the changes. 

Notes

· Cyclic Logging is for continual logging after memory has filled, previously stored data will be overwritten.

· Pit Stop Beacon reserved for future software releases.
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Logging Table Channel Setup

Use this function to setup the sample rates for each of the channels that you want to log.

1. On the menu bar under Logger, click Logging Table. 

The available channels and current sample rates will be displayed. 

2. Double-click on the channel you want to change the sample rate on. 

3. Pick a new sample rate from the available options window. 

4. Click OK. 

The LCU has a fixed amount of logging memory and has a maximum through put of samples which dictates

the logging rates for channels. If you choose to log channels at a high rate you will reduce the total number of

channels that you can log. If a channel does not vary much during a lap, for example; temperatures, pressures

then choose slower logging rates.

5. Repeat step 3 for the next channel. 

6. Click OK to accept the changes. 

Notes

· The number of channels enabled and the total logging time is updated each time you make a change. 

· Hold the Ctrl key and select multiple channels to change more than one channel at a time. 

· The  Channel  Logging  Rate  of  LCU  Battery  also  controls  the  refresh  rate  of  the  Comms  screen.  It  is

recommended to keep this rate at 50Hz or Higher.
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Outing data

This function allows the user to enter outing specific data that  will  be stored with each downloaded data set.

This information also helps identify each logger outing when browsing for specific data files with the analysis

program. It should be updated prior to each outing and can be edited in the Analysis program post downloads.

1. On the menu bar under Logger, click Outing Data. 

2. Enter the Driver and Car Names. 

3. Type in any text Comments for the data set in Line 1 and Line 2. 

4. Enter track Name and Length.

Beacon Mask is reserved for options in future software releases.

5. Click OK to save changes. 

Notes

· The Outing Data is saved and will be downloaded as part of each Logger Data set and can be edited in the

Analysis program. 

· Beacon Option will be available at later time.
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Setup Sheet

This  function  allows  the  user  to  enter  vehicle  and  track  specific  setup  data  that  will  be  stored  with  each

downloaded data set. 

1. On the Logger menu, click Setup Sheet.

2. Type in any text Comments for the data set. 

3. Click OK to save or Print to print a hard copy.

Notes

The Setup Sheet is saved and will be downloaded as part of each logger data set. 

Engine Logbook

The engine logbook is a dedicated area of memory in the logger that records the performance and use of an

engine. This function records the total time that a particular channel is above or below the defined threshold.

This data is not reset but is accumulated between downloads and is saved as part of each data set.

 In  order  for  these  to  function  correctly  you  must  have  one  digital  channel  set  to  System  RPM.  For  Digital

channel set-up information refer to Setup

The logbook can only be reset using the Reset Logbook function in USB Comms and ideally should be reset

after a engine change before you start the engine for the first time..

1. On the Menu Bar under Logger, click Engine Logbook. 

2.  Double-click on the channel threshold you want to edit. 

The logbook channel editor window will open and display the current settings for the selected channel.

3. Select a channel from the drop down combo box. 

4. Enter the active trigger threshold. 

5. Select either the Under or Over mode. 

6. Click OK. 

7. Repeat step 2 for additional channels. 

8. Click OK to save changes. 

Notes

· An Engine name and Serial number can also be set in this window. 
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Hide ECU Channels

If you are using your logger without an ECU interface you can use the Hide ECU Channels menu option. 

1. On the Menu Bar under Logger, select Hide ECU Channels.

A check mark will be placed next to the option indicating all ECU channels will be hidden in logger setup.
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Channels

Channel Data

Channels

Use this function to view each of your global channel settings.

1. On the Menu Bar under Channels, click Channel Data. 

The  Channel  Data  window  will  open  and  display  all  available  logger  channels  along  with  the  parameters

defined for each. 

Double click a channel to display selected channels properties.

Options

When you right-click over any of the channel definitions the popup menu with the following options will open.

· Edit Channel -  Opens the channel edit window for selected channel.

· Group Names - Opens the window for editing your group names. 

· Print Definitions - Print the definitions for all of your defined channels. 

· Print ID's - Prints the channel ID's and types for your analog channels. 

· Print ECU Def's - Print the definitions for your ECU channels. 
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Editing

Use this function to edit each channels global settings.

1. On the Menu Bar under Channels, click Channel Data. 

2. Double-click on the channel you want to edit. 

· You can edit any of the channel parameters except the Name and ID. Channel names can only be changed

using Channel Parameters  in the Calibration editor window.

3. Edit each of your channel settings. 

4. Click OK to save changes. 

Graph Scaling

· Upper Scale - Sets the upper scale for the graphic displays. 

· Lower Scale - Sets the lower scale for the graphic displays. 

· Auto Scale - Disables the upper and lower scales and forces the data to fit the window size. 

· Screen Max - Sets the maximum % of screen used when Tile Graphs option is enabled. 

· Screen Min - Sets the minimum screen % used when Tile Graphs option is enabled. 

Display

· Filter - Opens the channel filter window. 

· Color - Opens the color palette and sets the default channel color. 

Resolution

· Graphics - Sets the number of decimal places for the graphic displays. 

· SW Dash - Sets the number of decimals for the steering wheel dash. 

Notes

· The channel group can also be changed from this window. 
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Filters

Use this function to set the digital filters for each channel.

1. On the Menu Bar under Channels, click Channel Data.  

2. Double-click on the channel you want to edit.

3. Select the Filters button. 

4. Select the filter Type for the channel. 

5. Set the different filter options. 

6. Click OK to save changes. 

Filter Types

· None 

· Smooth - Averages the data using the number of Smooth points defined. 

· Low pass - Allows a signal below a certain value and excludes all others.

· High pass - Allows a signal above a certain value and excludes all others.

· Band pass - Allows signals between two specific frequencies and excludes all others.

· Band reject - Rejects signal frequency within a specific band, while passing out-of-band signals.

Windows

· Hamming - Has 20% faster roll off 

· Blackman - Has better stopband 

· Raised Cosine 

· Rectangular - No window 

Notes

· A higher Kernel length means a sharper roll-off but longer calculation time. 

· The number of smooth points only applies when using the smoothing type filter. 
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Creating (Edit) Calibrations

When  calibrating  a  sensor  you  define  a  set  of  points  by  specifying  x  and  y  coordinates.  A  minimum  of  two

points are required to create a linear calibration curve. Ideally the calibration should include two points close to

the  maximum and  minimum raw  values.  Non-Linear  type  calibrations(Interpolation)  for  temperature  sensors

require more data points.

A pressure transducer may have a output signal range of .5 volts to 4.5 volts. The LCU converts this voltage to

a Binary representation. QwikData 2 is a 12 bit system with a maximum resolution of 4096 counts(bits).  At 0.0

psi the sensor output is .5 volts or 414 bits, at 100 psi the sensor output is 4.40 volts or 3605 bits. A sensor

calibration refers to voltage output as X and the bit count as Y.

A  complete  understanding  of  Sensor  Calibration  is  not  necessary.  The  Import  Sensor  Calibration

function is a simple direct procedure for calibrating most QwikData 2 sensors.

Three procedures for creating Sensor Calibrations are available in QwikData 2. Refer to the underlined links

below for more information.

1.   Importing  Calibrations.  The  simplest  most  direct  procedure  for  creating  sensor  calibrations  is  to  import

calibrations  from  a  list  of  sensors  organized  by  part  number  and  accessed  with  the  Import  function  in  the

sensor calibration window.(Microsoft Office Excel must be loaded on computer to function)

2. Calibrating in Manual ADC Count.  Follow the Manual ADC Count procedure to manually enter the X and Y

sensor  calibration  points  from  the  keyboard  for  you  sensors.  This  is  a  useful  procedure  if  you  are  using  a

sensor supplied with specific calibration information.

3.  Calibrating  from  Sensor  Output.  If  the  output  of  the  sensor  is  dependant  on  how  it  is  installed,  (a  linear

potentiometer  used  to  measure  damper  movement  or  throttle  position  for  example)  then  it  is  easier  to  use

direct  sensor  readings  from  the  logger  for  the  X  calibration  point  while  communicating  with  the  logger  to

calibrate the channel.

Notes

· It is helpful to first assign Channel names and setup graph scaling's in Channel Parameters for the channels

you will be calibrating.

· Channel  names  must  be  entered  under  Channel  Parameters  in  the  Calibration  Window.  The  Channel

Scales, Color and Decimal Points may also be edited in the  Channel Data Window.

· Microsoft Office Excel must be loaded in computer for Import Calibration Window to open properly.
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Channel Parameters

The first step in calibrating a channel is to set the channel parameters. Channel parameters are what defines a

particular channel.

1. Under Channels on the menu bar select Edit Calibration, the Calibration Window will open.

2.  From  the  Calibration  Window  menu  bar  under  Channel,  click  Select  Channel  or  Ctrl  L.  Choose  the

channel for calibrating from the list.

    

  3. From the calibration window menu bar under Channel select Channel Parameters. 

4. The channel parameter editor window will display the parameters for the selected channel.. 

5. Select Name and enter a name for the channel. 

6. Select Units and enter the units that you want the sensor data displayed in.(psi ,inHg, Deg F. etc.)

7. Select Graphics and enter the number of decimal places to which the channel data is displayed. 

8. Auto Scale sets the channels upper and lower graph scales automatically based on recorded data values.

9. Select Color and choose a default color for the channel from the defined palette. 

10. Click OK to save changes. Repeat steps 2 thru 10 for each sensor.

Notes
· It is recommended that the channel Filter parameter is set to none during calibration. 

· Graph Scales will be applied to Calibration Window graph and Analysis Channel graph.

· Dashboard drop down feature is reserved for future software releases.
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Importing Calibrations

Most  users  find  this  calibration  procedure  the  simplest  and  most  direct.  Follow  these  functions  to  Import

calibrations for your sensors. Microsoft Office Excel must be loaded in computer.

· Be  sure  to  assign  channel  names  and  edit  channel  parameters  before  creating  calibrations.  (see

Parameters). Un-named channels will be listed as LCU location or ANA##.

1. From the menu bar under Channels select Edit Calibrations(Ctrl+C), this will open the calibration window.

2. In the calibration window menu bar under channel click Select Channel.

3. From the Analog Channels window double click the channel you want to calibrate.

4. From the menu bar under file select Import.
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5. Select the tab to display the sensor type i.e: Pressure,Temperature, Lambda.

· Sensor calibrations are listed by part number or description and are available in various ranges and
units.

6. Double Click on a sensor name to select.

· The calibration window will reopen with the selected calibration applied.

7. Repeat steps 2 thru 6 for next sensor.

8. To save changes exit Calibration Window or under File on the menu bar select Save Changes .
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Calibrating in Manual ADC Count

Follow  the  Manual  ADC  Count  procedure  to  manually  enter  calibration  points  from  the  keyboard  for  your

sensors. This is a useful procedure if you are using a sensor supplied with specific calibration information. Be

sure to edit the selected channels parameters before creating a calibration(see Parameters).

1. Open the calibration window and select the channel you want to calibrate. 

           

2. On the calibration window menu under Channel select Manual ADC Count, a check should appear.

3. On the Calibration window Menu Bar under Calibrate, select Insert Value. 

4. Enter the Y Value (Units)

Hit OK

5. Enter the X Value (Bits)

Hit OK

The graphic display is updated as points are added to the calibration grid.  If  calibration points  exceed graph

adjust graph scaling in step #7 of Parameters.

6. Repeat step 2 to enter more calibration points if necessary. 

7. Enter a Calibration Type

8. Close to save changes.
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Calibrating from Sensor Output

If  the  output  of  a  sensor  is  dependant  on  how  it  is  installed;  for  example,  a  linear  potentiometer  used  to

measure damper movement or throttle position Calibrating from Sensor Output is very useful.

Calibrating using direct sensor readings requires USB comms to be open and online with the LCU and LCU 12

volt power ON. In the Calibration window under Channel the Manual ADC Count must also be unchecked. Be

sure to edit the selected channels parameters before creating a calibration(see Parameters).

1.  Open the Calibration window and select the channel for calibrating. If  you are connected to your  LCU the

real-time channel reading in the status bar is active showing the current output from the selected sensor and

can  be  used  to  monitor  the  response  of  the  sensor  as  it  moves.  The  lower  right  corner  of  the  calibration

window should read Connected. The calibration points in the grid are plotted on the graph. 

         

2. Hit the Enter Key, a window for Y Value should open, set sensor to known value for Y, enter value of Y in the

window and hit Enter Key again to record calibration point. 

3. Repeat steps to record more calibration points. 

4. Close window to save Calibration.

       

Notes

· You can use the Del key to delete unwanted calibrations points for the selected grid cell. 

· Use the Edit Value menu to edit existing calibration points. 

· The  first  four  available  channels  on  the  channels  list  are  LCU  internal,  the  connection  status  will
always read Not Connected for these channels.
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Calibration Types

The calibration window allows five calibration curves that can be fitted to your points to define the response of
the sensor over the entire measurement range. The calibration options are:

· Linear y= ax + b (Most  sensors  use  this  type)  Sensors  such  as  displacement  transducers  or
pressure  sensors  that  are  calibrated  on  the  car.  This  type  draws  the  best  straight  line  through  all  of  the
points.

· Interpolation Mostly used for temp sensors or anything that is non linear or not able to be well defined by
the other types.

· Quadratic y = ax² +bx + c Any multi  point calibration that  can be curve fit  to a quadratic  type.  RTDs and
small range temps sensors.

· Table with Hold  Gear  position,  clutch  or  nitrous  switch  calibration.  System draws  a  step  function  to
define the change points.

· Scale & Offset Any sensor that is supplied with simple scale and offset values for its calibration by the
manufacture.
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ECU Calibration

To view ECU channel data in engineering units it must be calibrated by applying a scale and offset to the raw

data.

1. On the Channels menu, click ECU Calibration. 

2. Select the channel you want to edit from the combo box. 

3. Enter the calibration Scale value. 

4. Enter the calibration Offset value. 

5. Repeat step 2 for any additional channels. 

6. Click OK to save changes. 

Digital inputs

Digital  channels  (also  referred  to  as  Frequency)  can  be  used  to  measure  RPM,  Speed,  Frequency,  Pulse

Counts  and  Digital  Events.  The  QwikData  2  Basic  System  has  1  Tach  Input  and  1  digital  input.  Harness

connectors are labeled Tach Input and Freq. 2. The QwikData 2 Advanced system has 4 digital channel inputs.

Harness connectors are labeled Tach Input, Freq. 2, 3, and 4. The Tach Input and Digital Inputs 2 thru 4 are hi

speed digital input channels. Digital #5 - Pin 15 of the 34 pin Basic LCU connector and Digital #6 - pin 26 of the

Advanced 26 pin connector can be wired to as low resolution digital inputs. This input acts as a counter each

time a digital event occurs (the counter resets to zero each time the logger power is cycled). For information

regarding Tach Input or Digital Speed Sensor connections to a digital channel refer to examples Connecting a

Tach Input, Connecting a Digital Speed Sensor.

NOTE

· Reed Switch Speed Sensor #91116 purchased before Sept.09 require a .33uF capacitor be soldered across

the signal and ground wires inside the Switchcraft sensor connector.
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Digital Input Setup

Use this function to setup your LCU digital inputs as speed channels. 

The logger references a System Speed input for both the logging criteria(not necessary if activating logger with

Switch Activate option)  and for the engine logbook. In order for these to function correctly  you must  have at

least  one  digital  channel  set  to  System  Speed  or  System  RPM.  If  no  digital  RPM  inputs  are  available  for

System RPM the logger must be enabled with a switch. See Logger Enable Conditions.

1. Assign Channel name in Name window.

2. On the menu bar under Channels, click Digital Inputs. 

3. Select a Input Type for Digital channel. 

4.  If  connected  to  a  tach  output  signal  for  engine RPM enter  the number  of  pulses  per  engine revolution.  If

using  a  trigger  wheel  or  flying  magnet  enter  number  of  magnets  or  Teeth  on  trigger  wheel.  The  logger

calculates distance and speed from the number of pulses received from the wheelspeed sensors and the tire

diameter of each wheel. 

5. Select trigger edge for sensor signal. Most sensors trigger off rising edge. If data is inconsistent or has drift

and pulses per rev are correct try changing Trigger Edge.

6. Click OK to save changes. 

· The  System  Speed  Button  allows  users  the  option  of  combining   two  or  more  channels  to  create  your

System Speed channel. 

1. Open the Digital Inputs setup and press the System Speed button. 

2. Select the Active Inputs to be used. 

3. Pick one of the Mode options. 

          Note: To set Properties for Digital Input Channels select channel from Channel Data Window.

· Reed Switch Speed Sensor #91116 purchased before Sept.09 require a .33uF capacitor be soldered across the signal

and ground wires inside the Switchcraft sensor connector. Refer to Connecting a Reed Switch Speed Sensor.



39

Configuration

Edelbrock QwikData 2

Auxiliary Outputs

Auxiliary outputs are switched ground outputs controlled by the logger using Auxiliary Output channels 1 or 2

and a set of defined conditions for a specified logged channel.

Examples may be a dash lite activated by a channel programmed to alert a condition ie: RPM shift lite, low oil

pressure warning, excessive fluid temperature, low or hi nitrous bottle pressure etc.

Auxiliary  Output  is  rated at  1.5  AMP max.  For  triggers  exceeding  1.5  AMP's  output  can  be  configured  to

activate a relay that controls another function ie: nitrous bottle heater or solenoid. When triggered the output

from the harness will supply path to ground. 

Auxiliary Output example diagrams

Relay Circuit  Warning Lamp Circuit

    

Note

· All Auxiliary outputs switch path to ground when activated.

Channels

Use this function to view and edit each of your axillary output channel settings.

1. In the Channels menu, click Auxiliary Outputs. 

The setup window will open and display all of your auxiliary outputs along with the parameters defined for each.

Auxiliary outputs are switched outputs controlled by the logger using a channel and a set of defined conditions.
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2. Double-click on a channel and the parameter edit window will open. 

3. Select the channel you want to use and edit any of the channel enable conditions. Next click on the Enable

Output check box.

4.Click OK. 

5. Close the window to save your changes. 

Notes

· When triggered the output from the harness will supply path to ground. 

· It is recommended that any unused outputs are disabled. 

Limits

· Threshold - Sets the activation value for the channel selected. 

· RPM Limit - Sets the engine RPM threshold. 

· RPM Qualified - Enables the RPM qualification feature. 

· Mask Time - Sets the mask time before the output will activate. 

· Output - Defines which output is to be controlled. 

Condition

· Greater Than. 

· Less Than. 

· Equal To. 

· Not Equal To. 



41

Configuration

Edelbrock QwikData 2

Copy/Save Cals.

Use this function to copy your calibrations from a source to a destination. The source and destination can be

either  a  car  or  a  library.  The  ability  to  save  and  copy  calibrations  saves  time  when  you  change  sensors

between cars, correct mistakes or use different sensors for testing and competition. To create a New Library to

back up your selected calibrations choose New Library under File on the Copy Calibrations Menu Bar.

1. From the Menu Bar under Channels, click Copy/Save Cals. 

The Copy/Save window will open displaying the current settings for the source and destination fields and a list

of your calibrations.

2. Check the Copy to many Channels check box.

The calibration list window will now be split into two separate lists for the source and destination channels.

3. Select either a Car or Library from the Source Cal Type: combo box. 

4. Select a calibration file (Car ##-) or Library __.LIB with the Source combo box using the pull down .. 

Each  time  you  select  a  different  source  the  calibration  window  will  update  showing  each  of  the  calibrations

stored for your current selection.
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5. Select either a Car or Library from the destination Cal Type combo box. 

6. Select a calibration file (Car##-) or Library __.LIB with the Destination combo box using the pull down . 

7. Select all of the calibrations that you want to copy in the calibration list on the source side of the window.

8. Choose the channels from the destination list that you want to apply your calibrations.

To choose a sequential group of items, select the first calibration item, hold down the Shift key and then select

your last calibration item. All items between the first and last will be selected. To choose a discontinuous group

of items, hold down the Ctrl key and select each item.

9. Click Copy to copy your calibrations.

Notes.

· You can browse for a new library path by clicking the [...] button. 

· If  not  using the copy to many channels function or  copying to a new library the copied  calibrations  will  be

placed in the same channel I.D location in the destination file as the source file.  Channel I.D numbers are

listed in Channels - Channel Data in the RH column.
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Comms.

Oscilloscope

Use this function to open the real time oscilloscope display and monitor the input voltages for any of the logger

analog channels.

1. Connect the USB Communication Cable to the LCU and power up the logger.

2. On the Comms menu, click Oscilloscope. 

3. Click on the CH1 button. 

4. Pick a new channel from the available list. 

5. Click OK. 

6. The data for the new channel will display.

 

Notes

· You can set both the vertical scale (volts/div) and time base (sec/div) on the display. 

· Click on the cursor checkbox to enable the numeric channel display. 

· The 3 internal logger channels cannot be monitored by the oscilloscope function. 
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Configuration Icons & Hot Keys

Hot key Icon Menu Description

Ctrl+R Register LCU's Register the serial numbers for each of your LCU's.

Ctrl+P Print Print the setup for the current car.

Ctrl+Q Exit Exit the program.

Ctrl+L Logging Table Open the logger channel setup window.

Ctrl+E Engine Logbook Open the engine logbook window.

Ctrl+A System Alarms Open the Alarm setup window.

Ctrl+C Edit Calibrations Open the analog channel calibration editor window.

Ctrl+D Digital Inputs Open the digital channel setup window.

Set Current Car Opens the Set Current Car window

Ctrl+S Setup Sheet Opens the Setup Sheet

Outing Data Opens Outing Data Sheet

Channel Data Opens Channel Data window

Ctrl+O Oscilloscope Open Oscilloscope window
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USB Communication

To open the Communication program from your desktop click the USB Comms Icon on your desktop.

The  USB  Communications  module  is  the  main  interface  between  your  computer  and  LCU.  It  features  an

advanced user configurable window monitor along with tools for downloading data and sending setups.

The monitor allows the user to create any number of windows to display channel data. Once a screen format

has been defined it can be saved to disk allowing multiple setups to be created and reloaded depending on the

particular application.

A variety of functions are provided for setting up and downloading the data logger. New firmware can also be

loaded from within this module.
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File

Opening a saved Template

· A Sample Comms screen is included in the software. From the menu bar select File - Open and select the

settings.nsb  file  from  the  Power  to  Win  directory.  See  Editing  windows  to  further  customize  channel

windows. When completed select Save As from the menu bar under File  and assign new Comms Screen

name.

Use this function to open a saved display template. Each of the display windows with its controls and loaded

channels will be restored to the previously saved state.

1. On the Menu Bar under File  click Open. 

2. Select the drive and folder where the display setup is located. File type (*.nsb)

3. Double-click the display setup file or click OK to open it. 

Notes

· A Sample Comms display screen is included in the software. settings.nsb

Creating New USB Windows

This function is used to create a new USB channel display window. Once created channels can be added to

the window.

Open  the  Communications  program  and  connect  the  USB  cable  between  your  laptop  and  LCU.  Verify

communication ON LINE in lower right corner of screen.

1. Under the Window menu, click New Window. 

2. A blank new channel window will open. 
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3. Right click anywhere on the new window to open window options.

4. Assign window name, set font and Edit Channels for display. To display channels in window select Edit

Channels.

       

5.  Select  tile  from window menu  and  repeat  steps  1  and  2  to  create  multiple  windows.  It  can  be  helpful  to

group channels and tile windows when monitoring several channels. 

6. Save Window Template Saving a Template.

Notes

· Windows can be resized and moved by grabbing borders with mouse.

· See the section on Editing windows for further information about customizing your display. 



48

USB Communication

Edelbrock QwikData 2

Editing windows

Once a  New Window has been created the channels displayed and the font can be edited. Right-click over the

window and the popup menu with the following options will appear.

Window Name

This menu is used for editing the name of the current window.

Set Font

This function is for changing the font type and size for the numeric display data.

Edit Channels

This function is for editing the channels displayed in the current window. A check by the channel name displays

the channel.

· If changes are made to Channel Calibration Parameters in the Configuration program (Channel name

or decimal point)  USB Comms must be closed and re-opened or USB Cable removed momentarily

for changes to take effect on Comms. screen. 
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Zero Channels

The  Zero  Channels  function  resets  all  the  calibration  offsets  for  the  channels  in  the  current  window.  This

feature is  most  useful  for  accelerometers  and   sensors  such as  suspension  travel  sensors.  Ex:  The vehicle

would  be  setup  at  its  normal  static  ride  height  including  full  tanks  and  driver,  then  the  suspension  travel

sensors  would  be zeroed.  After  being  zeroed,  the suspension  travel  values  would  be  displayed  as  plus  and

minus values relative to static ride height. Zeroing pressure and temperature transducers is not recommended.

 

1. Right Click mouse over Channel Window containing channels for zero.

2. Select Zero All Channels.

3. Enter zero value and click OK to complete

· You can also adjust channels individually by right clicking on a channel i.d number.

· The Logger must be on and connected to the PC for this function to be active.

Saving a Template

Use this function to save the current screen setup. 

1. On the Menu Bar under File, click Save As. 

2. Select the drive and folder where you want to save your setup. 

3. In the File name box, type a name for the setup. 

4. Click Save to save changes. 

Notes

· Screen setup files are saved with file type (*.nsb) extension.

· You can use the Save menu item, to save using the existing name. 
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LCU Configuration

Use this function to display information about the LCU's current configuration. 

1. On the File menu, click LCU Configuration. 

2. The Configuration window will be displayed. 

3. Click OK to close the window. 

Reset Engine Logbook

The logger continuously collects specific engine parameters as defined by the settings for your engine logbook

setup. Use this function to reset the engine logbook data.

1. On the File menu, click Reset Logbook. 

2. A dialog will appear to confirm you wish to continue. 

3. Click Yes to reset the logbook. 

Notes

· Once reset is selected all existing Engine Logbook data will be erased.

· Engine Logbook should be reset after each engine change.
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Logger

Downloading Logged Data

Use this function to download data from your logger to your laptop. Once downloaded the data can be viewed

with the Analysis module.

Open  the  Communications  program  and  connect  the  USB  cable  between  your  laptop  and  LCU.  Verify

communication ON LINE in lower right corner of screen.

Open USB Comms program.

1. On the Logger menu, click Download. 

 A progress bar will briefly display indicating download progress.

 After the download is complete the setup is automatically re-loaded. 

Notes

· You cannot download the logger while it is still recording data. 

· If Logger is empty a window indicating LCU has no data to download will display.

· See  the  section  on  Register  LCU  in  Configuration  for  information  on  specifying  download  paths  for  your

logger data. 

Stop Download

Once the download routine has started you can interrupt the process using this function.

1. On the Logger menu, click Stop Download. 

2. A dialog box will appear with options on resetting the logger. 

Notes

· Press Yes to reset the logger and exit. Any recorded data will be lost. 

· Press No to exit without resetting. Any further logging will continue from where it last stopped. 

· Press Cancel to continue downloading. 
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Auto Download

When this feature is enabled the logger will automatically start the download process when a valid USB cable

connection to a computer is detected.

1. On the Logger menu, click Auto Download. 

 A check mark indicates the Auto Download feature is now enabled. 

 2. Click Auto Download again to disable this feature. 

Notes

· You cannot download the internal logger while it is still recording data. 

· See  the  section  on  Register  LCU  in  Configuration  for  information  on  specifying  download  paths  for  your

logger data. 

Send Config

When you have made changes to your car setup in Configuration use this function to send a new Setup file to

the logger. The memory buffer will be cleared and any existing data will be overwritten and lost.

1. On the Logger menu, click Send Config. 

· The current setup registered to the LCU will be sent to the logger. 

Notes

· You cannot send a new setup to the logger while it is recording data. 
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Extract Setup

The  extract  setup  feature  is  a  standalone  function  used  to  retrieve  an  unknown  setup  from  the  logger.  If

necessary you can import this file into configuration and overwrite the current car setup.

1. On the Logger menu, click Extract Setup.

· The Extracted file is saved and named extract.stp with the setup files. To access this file use the Add New

Car function in the Configuration module, choose Import and double click the extract.stp file. The extracted

setup has now been added to your setup folder list as the next available car.

Session Data

Use this function to change the session data for subsequent data sets. Setting these values helps to identify

specific data sets later on when using the Analysis module.

1. On the Logger menu, click Session Data. 

2. The session data edit window will open. 

3. Enter the Session, Outing, Out Lap and Pace Lap numbers. 

4. Click Update to save changes. 

Notes

· The lap counter will automatically increment after receiving a beacon signal. (Beacon transmitter necessary)

· The outing counter increments after each data set is downloaded. 

· Session  data  can  also  be  edited  after  the  logger  has  been  downloaded  to  disk  from  within  the  Analysis

module. 
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Syscon

Load Hex File

Sometimes Firmware updates may be necessary. Use this function for loading a new version of firmware into a

LCU.

Warning : Failure to load the correct version of firmware into an LCU may result in loss of functionality and/or

non  operation.  In  some  cases  the  LCU  may  have  to  be  returned  to  the  factory  for  repair.  Contact  your

Edelbrock representative for further information about loading firmware.

1. On the Syscon menu, click Load Hex File. 

2. Select the drive and folder where the file is located. 

3. Double-click the hex file or click OK to select it. 

 A progress bar will display during the programming routine. 

Notes

· After loading a hex file the LCU must be powered down and restarted before it will function. 

· Only hex files of the type (*.HEX) can be programmed into the LCU. 

Refresh Calibration

Refresh Calibration updates the data on the USB Comms window as changes are made to calibrations in the

configuration program without having to re-open USB Comms. 

Example:

If  Channel  Calibration's  are  not  displayed  correct  on  the  USB  Comms  Windows  open  the  Configuration

program, correct  sensor calibration, change back to USB Comms and select  Syscon-  Refresh Calibration.

The  channel  calibration  will  be  refreshed  and  should  read  correctly  reflecting  the  changes  you  made  in

Configuration.
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Protect Data

When this feature is enabled the logger data buffer is preserved after a download. Any subsequent logging will
continue from where it last stopped.

1. On the Syscon menu, click Protect Data. 

2. A check mark indicates the protect data feature is now enabled. 

3. Click on the menu again to disable this feature.

Start Logger

Use  this  option  to  manually  start  logging  data  while  monitoring  channels  in  the  USB  COMMS  module.  It  is

helpful for verifying logger download paths and setups prior to a outing.

NOTE: Start Logger option will not function if  Switch 3 (manual logging switch) is active in logger start  stop
setup. Use manual logging switch to enable logger.

1. On the Syscon menu, click Start Logger.

The MEM: ### counter in lower right of screen should start counting up.

· Manual Logging stops by repeating step 1.
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Data Analysis

Open the Data Analysis program by double clicking the Data Analysis Icon on your desktop.

 The Data Analysis  module is  a  powerful  tool  designed to  let  you  view and  manipulate  information  collected

from your data logger. Using the software you are better equipped to make informed decisions about your race

setup and make changes to improve vehicle performance.

More  detailed  analysis  may  be  achieved  by  combining  data  from  sensors,  mathematical  equations,  setup

information and knowledge of race engineering. However you use the information,  this tool  helps you decide

on what changes to make according to your interpretation of the data.

If you are going to make informed decisions then you must have confidence in your data. This can be achieved

by making sure that you have good quality data and that you are looking at and interpreting the data in the right

way.
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File

Add New Outing

Use this function to add a downloaded data file to the Data Manager. Downloaded data files are referred to

as Outings.

1. On the Menu Bar under File, click Add Outing. Or click Icon on menu bar 

2. Select the drive and folder where the Outing is located. Downloaded Data File location was designated when

you registered your LCU and set the download path in the Configuration utility Register LCU.

3. Click on the outing to read the file details and comments. 

4. Double-click the outing or click OK to open it. 

Notes

· To open a file you've used recently, you can use the Recent File menu list. 

· You can use the Replace Outing menu to replace the current outing. 

· Only outing files of the type (*.DAT) can be read by Analysis. 

· Analysis can be set to automatically open the last downloaded data file. For details see Auto Update.
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Replace Outing

Use this function to replace the current Outing in the File Folder. 

1. On the Menu Bar under File, click Replace Outing. 

2. Select the drive and folder where the new Outing is located. 

3. Click on the Outing to read the file details and comments. 

4. Double-click the Outing or click OK to select it. 

Notes

· To open a file you've used recently, you can use the Recent File menu list. 

· You can use the Add Outing menu to add a new outing to the File Folder. 

User Login

Certain features of QwikData 2 are password protected. This window is used when Edelbrock personnel need

to login and activate these features.

Print

Use this to print a hard copy of the current window.
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View

Time Plot

Use this function to open the time plot window. This plot is useful for looking at events that are independent of

the position of  the track or  when a wheelspeed input  is  not  available  to plot  against  distance.  Selected  data

should display.

1. On the Menu Bar under View, click Time Plot. 

The time plot  window will  open  and  display  a  graph  of  the  channels  loaded  in  the  file  folder  plotted  against

time.  The  scale  for  the  current  channel  is  displayed  on  the  left  axis  and  additional  channel  information  is

displayed at the top of the graph.

Select  the Add Channels Icon  from the menu bar to display a list  of  logged channels to display on the

graph.

2. Move the cursor horizontally to a point of interest. 

3. Right click to open the zoom and scroll popup menu. 

The channel numerical data for the current time will update as the cursor is moved. If the track map is open

the current position will also update.

Notes

· Clicking on a channel in the file folder makes it the new current channel. 

· Right click over the left axis to open the channel scaling popup menu. 
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Distance Plot

Use this function to open the distance plot window. This plot is useful for looking at events that relate to actual

track position.  Using the track window in  conjunction with  the distance plot  gives  an immediate  indication  of

position  on  the  track.  By  overlaying  data  from  several  laps  you  can  compare  visually  the  difference  in

performance at any point on the track.

1. On the Menu Bar under View, click Distance Plot. 

The distance plot window will open and display a graph of the channels loaded in the file folder plotted against

distance. The scale for the current channel is displayed on the left axis and additional channel information is

displayed at the top of the graph.

Select  the Add Channels Icon  from the menu bar to display a list  of  logged channels to display on the

graph.

2. Move the cursor horizontally to a point of interest. 

3. Right click to open the zoom and scroll popup menu. 

The channel  numerical  data  for  the current  distance will  update  as  the cursor  is  moved.  If  the  track  map  is

open the current position will also update.

Notes

· Distance Plot requires wheel speed and distance channel logging. 

· Clicking on a channel in the file folder makes it the new current channel. 

· Right click over the left axis to open the channel scaling popup menu.
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Entire Outing

If you are using a track beacon typically you will look at data for a single lap or part of a lap. You can use this

function to look at data from more than one lap at a time or even for the entire outing. 

1. On the Menu Bar under View, click Entire Outing. Or click Icon on tool bar 

The current plot will change and display the channels loaded in the file folder for the entire outing. The scale for

the current channel is displayed on the left axis and additional channel information is displayed at the top of the

graph.

2. Move the cursor horizontally to a point of interest. 

3. Right click to open the zoom and scroll popup menu. 

Double-click over a particular lap to make it the current lap and exit the entire outing view mode. You can also

use the Group Laps feature to look at several consecutive laps from the same outing.

Notes

· Clicking on a channel in the file folder makes it the new current channel. 

· Right click over the left axis to open the channel scaling popup menu. 
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Measure Cursor

Use  this  menu  to  open  the  measure  cursor  function.  This  feature  allows  you  to  measure  the  difference  in

channel values between two points on a time or distance plot.

1. On the Menu Bar select View, click Measure Cursor. Or select Icon from toolbar 

The measure cursor datum point will show at the cursor position for the current channel.

2. Click on the graph to locate the position of the datum point. 

3. Move the cursor over the graph to the measure point. 

The numeric  display  at  the top of  the window will  update  and  show the delta  x  and  y  values  for  the current

channel as the cursor position changes.

4. Click on a channel in the file folder and repeat to measure a different channel. 

Notes

· Measure Cursor on distance plot requires wheel speed and distance channel logging. 

· The measure cursor function is disabled anytime the graph is refreshed. 
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Logbook

Use this function to open the engine log book. This report provides detailed information about an engines on

load history. It provides cumulative data from when the logbook was last reset. 

1. On the View menu, click Logbook. 

The log  book  window will  open  and  display  a  tabular  report  of  the  eight  user  defined  engine  channels.  The

logbook  start  and  stop  time  and  date  are  displayed  at  the  top  of  the  report.  The  following  information  is

displayed for each channel

2. The maximum value for the channel. 

3. The longest time spent above/below the threshold. 

4. The total time spent above/below the threshold. 

The total running time, time under load, total distance and number of engine revolutions are also displayed on

the report.

Notes

· The engine log book can only be reset by using the Reset Logbook function in USB comms. 
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Event Markers

Use this menu to enable the event marker function. This feature displays information on when a channel value

reaches a certain condition as defined by the settings in the event marker editor.  e.g.  When the engine rpm

exceeded a threshold, how long the event occurred and what was the maximum value. 

1. On the View menu, click Event Markers. 

2. The event markers feature is now enabled. 

3. Click on the menu again to disable this feature. 

Notes

· Right click over the left axis to open the scaling's and event marker editor menu. 

· Event markers can individually be set and enabled for each channel. 
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Macro Toolbar

Use this menu to open the macro toolbar. The toolbar is highly recommended for a convenient way to quickly

review  your  data.  After  setup,  any  of  the  previously  defined  channel  and  window  layouts  can  be  instantly

displayed  by  clicking  on  a  index  button  in  the  Macro  Toolbar  window.  Up  to  fifteen  different  layouts  can  be

saved using the (F7) Save Macro function in the Window menu.  

1. On the View menu, click Macro Toolbar.

 

2. The toolbar will be displayed. 

3. To save a defined Plot and Channels select F7, the Save Macro window will display. Assign a Macro name

and available index number.

Example:  With Time Plot  open and 8 EGT channels and RPM plotted select  F7,  name as EGT's in  toolbar

index 0, select OK to save. With any data file open simply click index 0 from Macro Toolbar and EGT plot will

display. Create up to fifteen other Macro Toolbar shortcuts.

Notes

· Using any macro will delete the current channels and window layout. 
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Edit

Channel Properties

Use this function to view and edit each of your global channel settings.

1. On the Menu Bar under Edit, click Channel Properties

The channel  properties  window will  open  and  display  all  of  your  logger  channels  along  with  the  parameters

defined for each. This window supports name filtering. Press the first letter of a channel name and the window

will automatically refresh but only displaying the channels that start with that letter. You can also sort channels

by clicking on the top of any of the columns.

2. Double-click on a channel and the parameter edit window will open. 

3. Edit each of your channel settings. 

You can edit any of the channel parameters except the Name and ID. Channel names can only be changed in

Channel Parameters in the Calibration Editor of the Configuration module.

4. Click OK. 

5. Repeat step 2 for additional channels. 

6. Close the window to save your changes. 
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Outing Info

This function allows the user to edit the outing information stored with the current data set.

1. On the Menu Bar under Edit, click Outing Info. 

2. Edit the outing information as required. 

3. Edit any text Comments for the data set.  

You can also edit the start lap, session and outing numbers from this window. An offset to the lap count can

also be made by setting the number of pace laps.

4. Click OK to save changes. 

Notes

· Changes made to the outing information are permanently saved with the current data set. 
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Define Math Channels

Creating

Use  this  function  to  create  or  edit  your  math  channels.  This  feature  allows  complex  math  functions  to  be

created using your existing channels in combination with predefined functions, operators and constants. Math

channels  can  be  treated  as  ordinary  channels  and  can  be  graphed,  included  in  reports  and  even  nested  in

other math channels. 

1. On the Edit menu, click Define Math Channels. 

The math channel editor window will open and display any math channels that have been defined. The math

string  text  window is  a  simple  editor  and  can  be  written  to  directly  or  you  can  double-click  in  any  of  the  list

boxes to bring a channel, function, operator or constant into the math text string.

2. Under Channels select Create New Channel.

3. Enter a Name for the new math channel.

It is recommended that you select non-ambiguous names for your math channels and that they are dissimilar

to  any  existing  channels  and  defined  constants.  The  minimum  number  of  characters  allowed  for  a  math

channel name is 2. Any blank characters in the name will automatically be filled with the underscore character.

4. Click OK. 

5. Enter the math string for your new function. Enter manually or select available functions and operators from

window.

Certain operators have a higher precedence than others and effect how channels are calculated. Multiplication

and Division have higher precedence than Addition and Subtraction. If in doubt you can use parenthesis when

writing your math strings

6. Under File select Save Changes. 

· Your Math Channel is now available in the Add Channel Menu.

Notes

· Before you can test a math channel it must be first be created and saved. 

· Use the Select menu or Name button to view a different channel. 

· Use the Delete menu to remove an existing math function. 
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Importing

Use this function to import predefined math functions. 

1. On the Edit menu, click Define Math Channels. 

2. Click on the Import menu. 

3. Select the drive and folder where the math (*.TXT) file is stored. 

4. Double-click on the file or click OK to open it. 

5. Select the math functions you wish to import from the list. 

6. Click OK. 

7. You will be prompted to confirm if any duplicate names exist. 

8. Click OK to accept the changes. 

Notes

· You can use the Export menu to save math functions to a (*.TXT) file. 

Math Operators

Operator Description

+ Arithmetic summation
- Arithmetic subtraction
* Arithmetic multiplication
/ Arithmetic division
^ Arithmetic power

=> Boolean greater or equal
> Boolean greater than

<= Boolean less or equal
< Boolean less
& Boolean logical AND
| Boolean logical OR
# Boolean exclusive OR
% Modulo arithmetic
= Boolean equal
!= Boolean not equal

Notes

· Boolean functions return a value of zero (0) for false and one (1) for true. 
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Math Functions

Available Functions

ABS() - Returns the absolute value of the operand. The absolute value of a number is its unsigned magnitude.
For example, ABS(-1) and ABS(1) both return 1.

ACos() - Returns the arccosine value of the operand. The ACos function takes the ratio of two sides of a right
triangle and returns the corresponding angle in radians. The ratio is the length of the side adjacent to the angle
divided by the length of the hypotenuse.

ASin()  -  Returns  the arcsine  value of  the operand.  The ASin  function  takes the ratio  of  two sides  of  a  right
triangle and returns the corresponding angle in radians. The ratio is the length of the side opposite the angle
divided by the length of the hypotenuse.

ATan() - Returns the arctangent value of the operand. The ATan function takes the ratio of two sides of a right
triangle and returns the corresponding angle in radians. The ratio is the length of the side opposite the angle
divided by the length of the side adjacent to the angle.

Avg()  -  Returns  the  lap  average  value  of  the  operand.  The  Avg  function  sums  the  channel  values  for  the
current lap and divides the result by the total number of samples.

Ceil()  -  Returns  the lap  maximum value of  the operand.  The Ceil  function  finds  the  maximum value  for  the
current lap and returns this value for all samples.
 
Cos() - Returns the cosine value of the operand. The Cos function takes an angle and returns the ratio of two
sides of a right  triangle. The ratio is the length of the side adjacent to the angle divided by the length of  the
hypotenuse.

Delta()  -  Returns  the  difference  between  two  values.  The  Delta  function  returns  the  difference  between  the
operand of the datum lap and the current lap. If no datum is loaded a value of zero is returned.

Deriv() - Returns the derivative value of the operand. The Deriv function calculates the rate of change of the
operand at 3 sample intervals.

Exp() - Returns the exponential value of the operand, e (the base of natural logarithms) raised to a power. The
Exp function complements  the action of  the Log  function  and  is  sometimes referred  to  as  the antilogarithm.
The constant e is approximately 2.718282.

Floor()  -  Returns the lap minimum value of the operand. The Floor function finds the minimum value for the
current lap and returns this value for all samples. 

Gate_Avg()  -  Returns the gated lap average of  the operand.  The Gate_Avg function calculates the average
value of the operand but only using values that are not zero.

Integ() - Returns the integral value of the operand. The integral function calculates a running summation of the
operand at 3 sample intervals.

Ln() - Returns the natural logarithmic value of the operand. The natural logarithm is the logarithm to the base
e.

Log() - Returns the base-10 logarithmic value of the operand. It is calculated by dividing the natural logarithm
of the operand by the natural logarithm of 10.

Max() - Returns the running maximum value of the operand. The Max function tracks the maximum value of
the operand for the current lap.
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Min() - Returns the running minimum value of the operand. The Min function tracks the minimum value of the
operand for the current lap.

Not() - Returns the inverse value of the operand. The Not function returns the logical negation of the operand.
In addition the Not operator inverts the bit values of the operand.

Sin() - Returns the Sin value of the operand. The Sin function takes an angle and returns the ratio of two sides
of a right triangle. The ratio is the length of the side opposite the angle divided by the length of the hypotenuse.

Sqrt() - Returns the square root of the operand. The operand must be a value greater than or equal to zero

Tan() - Returns the tangent value of the operand. Tan takes an angle and returns the ratio of two sides of a
right triangle. The ratio is the length of the side opposite the angle divided by the length of the side adjacent to
the angle.

Notes
· The trigonometric functions return values expressed in radians. 
· To convert degrees to radians, multiply degrees by pi/180. To convert radians to degrees, multiply radians

by 180/pi. 

Math  Examples

Note:  The  following  math  channels  are  examples  and  should  be  treated  as  such.  Their  accuracy  and
usefulness is not guaranteed.

Name Engine_Rate
Syntax Deriv(RPM / 60)
Channels RPM
Definition The rate of change of engine speed.
-
Name Brake_Bias
Syntax F Brake Pressure / (F Brake Pressure + R Brake Pressure) * 100
Channels Front and Rear Brake Pressures
Definition The ratio of the braking pressures front to rear.
-
Name Compare_ET
Syntax Delta(Elapsed Time)
Channels Elapsed Time
Definition The cumulative time difference between the datum and current lap.
-
Name Gear_Ratio
Syntax (RPM / 60) / (Speed / (0.680 * 3.1415))
Channels RPM and Speed
Definition The ratio of speed between the engine and driven wheels.
-
Name Ride_Height
Syntax (FL Damper + FR Damper + RL Damper + RR Damper) / 4
Channels Vehicle Dampers
Definition The simple definition of vehicle ride height.

Notes

· It  is  recommended  to  use  constants  to  define  any  numeric  values  to  improve  calculation  accuracy  and
speed. 
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Define Constants

Creating

Use this function to create or edit your system constants. Constants are names that equate to numeric values

used in your math channels and can be global or outing dependant. Use the appropriate check box to select

which type you want to edit.

Global constants are made available for all math channels for values that do not change from one outing to the

next. Outing dependant constants are for values that change with each outing and are stored with the current

data set.

1. On the Edit menu, click Define Constants. 

2. Click on the Create button. 

3. Enter the Name for the new constant and its Value. 

Analysis also supports the use of links for defining constants. See the section on defining and using links later

in this section.

4. Click OK. 

5. Repeat step 2 for additional constants. 

6. Click OK to accept the changes. 

Using Constants

When a math channel that contains a constant is calculated, analysis first looks in the list of outing dependant

constants. If the value is not found a search is then made in the global constant list. If neither list contains the

constant the math channel cannot be calculated.

Defining Links

Constants can also be defined by links to values in  the cells  of  a spreadsheet  application such as Microsoft

Excel. The syntax for defining a constant link is :

Application Name | Sheet Name | Row Number | Column Number. e.g. excel|sheet1!r4c8.

This  example would return the value from row 4,  column 8  of  sheet  1  of  an open  Excel  spreadsheet.  If  the

application is not open or the cell does not contain a number a value of zero is returned.

Notes

· You can use the Copy to Outing menu to copy all global constants to the current outing. 
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Importing

Use this function to import system constants.

1. On the Edit menu, click Define Constants. 

2. Click on the Import menu. 

4. Select the drive and folder where the constant (*.TXT) file is stored. 

5. Double-click on the file or click OK to open it. 

6. Select the constants you wish to import from the list. 

7. Click OK. 

8. You will be prompted to confirm if any duplicate names exist. 

9. Click OK to accept the changes. 

Notes

· You can use the Export menu to save constants to a (*.TXT) file. 

Color Pallette

Use this function to edit the system palette colors. 

1. On the Edit menu, click Color Palette. 

2. Click on the Color you want to edit. 

3. Select a new color from the windows palette. 

4. Click OK. 

5. Repeat step 2 for additional colors. 

6. Click OK to accept the changes. 

Notes

· Custom colors can be defined using the windows palette control. 
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Current Calibration

Use this function to view and edit the calibrations of your analog channels for the current data set. Editing the

calibration  for  the  current  data  set  has  no  effect  on  the  calibration  in  your  setup  file.  The  edited  channel

calibration will be saved with the current data set.

1. On the Menu Bar under Edit, click Current Calibration. 

The calibration window will open and display the first analog channel. 

2. Under Channel on the Calibration window menu bar click Select Channel.

3. Select the channel for calibration and click OK. 

If you are connected to your LCU the real-time channel reading in the lower status bar is active showing the

current  output  from  the  sensor  and  can  be  used  to  monitor  the  response  of  the  sensor  as  it  moves.  The

calibration points in the grid are plotted on the graph.

The  calibration  window  will  display  the  x  y  points  for  the  selected  channel  and  refresh  the  graphic  display.

Make sure  that  the Manual  ADC menu is  unchecked if  you  want  to  edit  your  calibration  using direct  sensor

readings. 

4. Edit the calibration points by clicking on the values. 

5. Apply or clear any calibration offsets. 

6. Repeat step 2 for additional channels. 

7. Close the calibration window to save your changes. 

Notes

· Editing a sensor calibration in the analysis application will only apply to the current data set. 
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ECU Calibration

This function allows you to edit  the calibrations of  the ECU channels for  the current  data  set  if  you are data

streaming  data  from  an  Edelbrock  ECU.  ECU  channels  are  calibrated  into  engineering  units  by  applying  a

scale and offset to the raw data.

1. On the Menu Bar under Edit, click ECU Calibration. 

2. Select Standard Channels or Extended .

3. Select the channel you want to edit from the combo box. 

4. Enter the calibration Scale value. 

5. Enter the calibration Offset value. 

6. Repeat step 2 for any additional channels. 

7. Click OK to save changes. 

Notes

· Editing a sensor calibration in the analysis application will only apply to the current data set.
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Zero Channels

This function allows you to zero a channel calibration for the current data set. In certain conditions you may find

it useful to make a sensor read zero at a particular measurement. e.g. to set the vehicle ride height or neutral

position of a gear position sensor.

1. Under Edit on the Menu Bar, select Zero Channels. 

2. Select the channels you want to zero from the listbox. 

The current values for each channel at the current cursor location along with any existing offsets are displayed

in the listbox.

3. Enter the new Zero value. 

4. Click OK.

5. Select YES when prompted to apply offset.

Notes

· Use the calibration editor to remove offsets applied to a sensor calibration. 

· Editing a sensor calibration in the analysis application will only apply to the current data set. 
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Track

Insert Beacon

Use this function to enter lap beacons in the current data set. Beacons are useful when used to create a lap by
indicating the start and finish points on a run. By selecting the data between the two beacons useless data is
not displayed.

To insert a beacon in displayed data right click on the desired beacon location and select Insert Beacon. Select

 yes to verify the inserted beacon location.

You can also edit beacons by selecting Edit Beacons under Track on the menu bar. 

Select Insert/Delete to open the beacon editor window.

Select Insert to insert a new beacon at a specific time or highlight a existing beacon position and select Delete

to remove.

Select Shift.. to shift all beacons by a designated time.

Notes
· Any changes to the beacon data are permanently saved in the data set.

Setup Sheet

To view and edit the setup sheet notes select Setup Sheet under Track on the menu bar.
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Data

Hide File Folder

To maximize the viewing area for your graphs you can use this option to hide the file folder window.

1. On the Menu Bar under Data, select Hide File Folder. 

BEFORE

AFTER

2. The file folder will be hidden and the menu will be checked. 

3. Click on the menu again to restore the view. 

Notes

· You can also use the F5 hot key to perform this function. 
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Remove Scalings

Use this function to undo any temporary scaling changes that have been applied to the graph for the current

channel or channels.

1. On the Data menu, click Remove Scaling's. 

2. The edit window will open and display the current channel. 

3. Click on the All Channels check box if required. 

4. Click OK to save changes. 

Notes

· Channel  scaling's  cannot  be  removed  if  the  Make  Global  check  box  was  selected  in  the  edit  scaling's

window. 
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Outings

Add Outings

Use this function to add a new dataset to the File Folder.

1. On the Data menu, click Outings,  Add Outing(s) 

2. Select the drive and folder where the dataset is located. 

3. Click on the dataset to read the file details and comments. 

4. Double-click the dataset or click OK to open it. 

Notes

· To open a file you've used recently, you can use the Recent File menu list. 

· You can use the Replace Outing menu to replace the current outing. 

· Only dataset files of the type (*.DAT) can be read by Analysis. 

· Analysis can be set to automatically open the last downloaded data file. For details see Auto Update.
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Replace Outings

Use this function to replace the current dataset in the File Folder.

1. On the Data menu, click Outings, Replace Outing. 

2. Select the drive and folder where the new dataset is located. 

3. Click on the dataset to read the file details and comments. 

4. Double-click the dataset or click OK to select it. 

Notes

· To open a file you've used recently, you can use the Recent File menu list. 

· You can use the Add Outing menu to add a new outing to the File Folder. 

· Only dataset files of the type (*.DAT) can be read by Analysis. 

· Analysis can be set to automatically open the last downloaded data file. For details see Auto Update.
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Replace All Outings

Use this function to delete all of the datasets currently loaded in the File Folder and replace them with a single

new outing.

1. On the Data menu, click Outings, Replace All Outings. 

2. Select the drive and folder where the new dataset is located. 

3. Click on the dataset to read the file details and comments. 

4. Double-click the dataset or click OK to select it. 

5. The currently loaded outings will all be deleted. 

Notes

· To open a file you've used recently, you can use the Recent File menu list. 

· You can use the Add Global menu to add an outing to all open folders. 
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Delete Outing

Use this function to delete the current dataset from the File Folder.

1. On the Data menu, click Outings, Delete Outing. 

2. The current outing will be removed from the file folder. 

Notes

· To open a file you've used recently, you can use the Recent File menu list. 
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Laps

Next Lap

Use this function to replace the current lap with the next lap in the loaded outing.

1. On the Data menu, click Next Lap. 

2. The current lap will be replaced with the next in sequence. 

Notes

· You can also use the Ctrl+N hot key to perform this function. 

Previuos Lap

Use this function to replace the current lap with the previous lap in the loaded outing.

1. On the Data menu, click Previous Lap. 

2. The current lap will be replaced with the previous in sequence. 

Notes

· You can also use the Ctrl+B hot key to perform this function. 

Add Laps

Use this function to add one or more laps to the loaded outing in the file folder.

1. On the Data menu, click Add Lap(s). 

2. The available laps in the current outing will be displayed. 

3. Select the lap(s) to add to the outing of the file folder. 

4. Click OK to add the selected lap(s). 

Notes

· You can also use the Shift+F3 hot key to perform this function. 

· Select the Color button if you wish to set the selected lap to a single color. 

Replace Current

Use this function to replace the current lap in the file folder.

1. On the Data menu, click Replace Current. 

2. The available laps in the current outing will be displayed. 

3. Select the lap to replace in the outing of the file folder. 

4. Click OK to replace the current lap. 

Notes

· You can also use the Ctrl+F3 hot key to perform this function. 

· Select the Color button if you wish to set the selected lap to a single color. 
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Group Laps

Use this function if you want to display several adjacent laps at the same time. Group laps are displayed side

by side and are not overlayed.

1. On the Data menu, click Group Laps. 

2. Enter the number of adjacent laps to display at a time. 

3. Select the Entire Outing check box for all available laps. 

4. Click OK to save the changes. 

Notes

· You can also use the F3 hot key to perform this function. 

Delete Current

Delete Current Lap

Use this function to delete the current lap from the file folder.

1. On the Data menu, click Delete Current. 

2. The current lap will be removed from the file folder. 

3. Any open channels in the deleted lap will also be unloaded. 

Notes

· If there is only one lap loaded the outing will be removed from the file folder. 
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Auto Update

This  feature  automatically  replaces  the  current  outing  in  the  file  folder  with  new  data  immediately  after  the

logger  download  has  been  completed.  The  most  recently  downloaded  data  is  displayed  when  Analysis  is

opened.

· The current outing is replaced if more than one outing is loaded in the file folder.

1. On the Data menu, click Auto Update, On New Data. 

2. The auto update feature is now active and the menu will be checked. 

3. Click on the menu again to deactivate the feature. 

Tile Graphs

This feature changes the full graph view into tiles for each individual channel loaded in the file folder. There are

two mode of operation for this feature.

Automatic - The graph is evenly divided into the number of channels loaded in the file folder.

Manual - The screen percentage used for each channel is set manually under channel parameters.

1. On the Menu Bar under Data, click Tile Graphs.

2. Tile mode is now selected and the menu will be checked. 

3. Click on the menu again to restore the standard view. 

Before After

     

Notes

· Tile mode settings can be changed under the File, Options menu. 
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Groups

Channels  can be grouped for  quick  access.  Examples of  groups  may be Engine pressures,  Engine Temps,

Nitrous, Chassis, Speed etc. When a group is selected the channels in that particular group are displayed.

1. To organize channel groups on the menu bar under Data select Channels, Add Channels  or the icon 

   from the toolbar.

2. Hold the Ctrl key and select the channels you wish to Group.

3.  Select save and assign the Group a name.

4. Select ok to save the Group.

Notes

· To access your group, open the add channels window   and select the group name.

· To delete a Channel Group highlight group name and select Delete.
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Reports

Setup

This function allows the downloaded data for the current dataset to be organized in reports and formatted to a

Microsoft Excel Sheet.

1. From the Reports Menu select Setup.

2. Select a template and Application.

3. Select the Reports tab.

4. Select the New icon   to create a new Report.

5. Assign a report Name, select Report Type and click Add to add channels. Edit channels and method with

channel pull downs. Click OK to exit window, hit Apply in setup window and OK to save.

Notes

To open a Excel Report open  Excel Reports and double click report, Excel will open and display your report.
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Excel Reports

On the Menu Bar under Reports select Excel Reports.

This folder contains the reports created in the Setup  reports folder.

Double click on a Report to open the Excel Sheet for your current dataset.
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Analysis Icons & Hot Keys

Hotkey Icon Menu Description

Ctrl=P Print Print the current plot or report

Ctrl=Q Exit Exit the program

Ctrl+T Time Plot Open the time plot window

Ctrl+D Distance Plot Open the distance plot window

Ctrl+Y XY Plot Open the XY plot window

Ctrl+H Histogram Open the histogram window

Ctrl+M Measure Cursor Display the measure cursor

Ctrl+E Log Book Open the engine logbook window

Ctrl+O Outing Info Open the edit outing data window

Ctrl+I Enter/Edit Splits Open the split editor window

F5 Hide File Folder Hide the logger file folder window

Ctrl+X Track and Data Open the track map and data cursor windows

Ctrl+F1 Replace Outing Replace the current outing in the file folder

Shift+F1 Add Outing Add a new outing to the file folder

Ctrl+N Next Lap Change to the next lap

Ctrl+B Previous Lap Change to the previous lap

F3 Group Laps Open the group lap window

Ctrl+F3 Replace current lap Replace the current lap

Shift+F3 Add lap(s) Add lap(s) to the current outing

F2 Replace all channels Replace all channels in the current lap

Ctrl=F2 Replace current Replace the current channel

Shift+F2 Add channels to lap Add channel(s) to the current lap

Shift+Del Delete Channel Delete the current channel

Ctrl+S Scalings Open the channel scaling editor

Ctrl+C Channel color Open the channel color editor

Ctrl+Z Zero Channels Open the zero channel editor

Ctrl+G Entire Outing View the entire outing

Ctrl+U Undo Last Undo the last zoom command

Ctrl+L Scroll Left scroll plot to the left

Ctrl+R Scroll Right Scroll plot to the right

Ctrl+W Zoom All Return full lap view

Ctrl+A Lap report Open the lap report window

Ctrl+F Fuel Report Open the fuel report window

Ctrl+V Tile Graphs Change to the tile graph view

Shift+F5 Tile Vertically tile open windows vertically

Shift+F6 Tile Horizontally Tile open windows horizontally

Shift+F7 save Macro Save current screen as macro
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Harness  Details

This section covers the LCU Harness details.  The QwikData 2 Data Acquisition System is  available  in  three

configurations;  Basic,  Advanced  Thermocouple  and   Advanced  Analog  .  Harness  schematics,  pin-out

designations and connector details for each system are available in this section. These details may be useful

when setting up your QwikData 2 system.

To  make  the  installation  as  easy  as  possible,  the  wiring  harness  provided  is  completely  assembled  with

connectors  that  mate  to  the  supplied  sensors.  Each  sensor  is  connected  to  the  QwikData  2  unit  by  simply

mating the appropriate connectors.

Route the wiring harness as needed to make connections to the installed sensors. Avoid paralleling Data Log

wires with any ignition wiring (primary or secondary) To connect the circular connectors on the wiring harness

to the sensors, push the mating connectors firmly together and then turn the locking ring clockwise to lock the

connectors together. 

Refer to Suggested Harness Routing in the Harness Detail Section for assistance with routing you harness.

With  some installations  it  may  be  necessary  to  re-pin  the  LCU Connector  in  order  to  accommodate  sensor

location and available sensor input types. In these situations it  should only be necessary to move the Analog

Signal or Digital Signal wires in the LCU connector. The Sensor power and ground wires are all common. To

release the pins in the LCU Connector simply depress the single white rectangular shape button on the LCU

Connector.  Re-locate  pins  as  necessary  in  connector  then  depress  pair  of  white  rectangular  buttons  on

opposite side of connector to lock pins.

BASIC SYSTEM HARNESS PART #91290

The  Basic  System  includes  a  single  harness  with  8  analog,  4  thermistor  type  temperature  sensor,  1  Tach

Input, 1 frequency(digital) sensor connectors and 1 programmable switched output that all terminate at the 34

pin connector on the LCU. * Inputs 7-10 are configured for thermistor type temperature sensors.

ADVANCED THERMOCOUPLE HARNESS PART #91294

The  Advanced  Thermocouple  System  includes  two  harnesses;  the  Basic  System  Harness  and  a  second

harness with 4 additional Analog sensor  connectors,  2 frequency(digital)  sensor  connectors,  8 thermocouple

connectors and a additional programmable switched output that terminate at the 26 pin connector on the LCU.

* Inputs 7-10 are configured for thermistor type temperature sensors.

ADVANCED ANALOG HARNESS PART #91291

The Advanced Analog System includes two harnesses;  the Basic System Harness and a second harness with

12 analog sensor connectors, 2 frequency(digital) connectors and a additional programmable switched output

that  terminate  at  the  26  pin  connector  on  the  LCU.  *  Inputs  7-10  are  configured  for  thermistor  type

temperature sensors.
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Suggested Harness Routing
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#91290 Basic Analog Harness Details
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#91290 Basic Harness Schematic
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#91290 Basic Analog Harness LCU Connector pin assignments

34 Pin LCU Connector

PIN WIRE COLOR FUNCTION         (Ch I.D) PIN WIRE COLOR FUNCTION
1 BLK/ORG ANALOG 1          (0004)  18 BLK/WHT/ORG SENSOR GND
2 BLK/YEL ANALOG 2          (0005) 19 LT GRN SWITCHED OUT 1
3 BLK/RED ANALOG 3          (0006) 20 N/C RXD(FROM ECU
4 BLK/WHT ANALOG 4          (0007) 21 BLK/WHT/ORG SENSOR GND
5 BLK/BLU ANALOG 5          (0008) 22 GRAY VREF
6 BLK/VLT ANALOG 6          (0009) 23 GRAY VREF
7 BLK/GRN TEMP 7               (0010)  24 RED REG 12V
8 VLT/WHT TEMP 8               (0011) 25 N/C TXD(TO DASH)
9 TAN/WHT TEMP 9               (0012) 26 BLK/WHT/ORG SENSOR GND
10 BLK/GRAY TEMP 10             (0013) 27 BLK BATTERY GND
11 WHT/BLU ANALOG 11        (0014) 28 N/C
12 BROWN ANALOG 12        (0015) 29 N/C
13 LT BLU FREQ 1                (0064)  (TACH INPUT) 30 N/C
14 DK GRN FREQ 2                (0065) 31 N/C
15 N/C FREQ 5                (0068)  LOW RESOLUTION 32 N/C
16 BROWN SW 3 33 N/C
17 PNK/BLK 12V SWITCHED 34 BLK BATTERY GND

#91290 Basic Analog Harness parts and vendor details

QTY DESCRIPTION MANUFACTURER MANUFACTURER
PART NUMBER

1 34 POSITION SUPER SEAL HOUSING AMP 2-1437285-3

26 SOCKET TERMINAL, SUPER SEAL AMP 3-1447221-5

1 HOUSING, METRI-PACK 150 SERIES DELPHI 12110293

3 TERMINAL, FEMALE METRI-PACK 150 SERIES DELPHI 12084200

3 CABLE SEAL, METRI-PACK 150 SERIES DELPHI 12048087

1 TPA, METRI-PACK 150 SERIES DELPHI 12052845

1 HOUSING, METRI-PACK 150 SERIES DELPHI 12129615

3 CAVITY PLUG, METRI-PACK 150 SERIES DELPHI 12059168

1 TPA, METRI-PACK 150 SERIES DELPHI 12052845

13 EN3 MINI WEATHERTIGHT CONNECTOR SWITCHCRAFT EN3C4FC
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#91294 Advanced Thermocouple Harness Details
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#91294 Advanced Thermocouple Harness Schematic
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#91294 Advanced Thermocouple Harness LCU Connector pin assignments

    26 Pin LCU Connector

PIN WIRE COLOR FUNCTION         (Ch I.D) PIN WIRE COLOR FUNCTION         (Ch I.D)
1 GRY/BLK FREQ 3                (0066)             14 YEL K-TYPE 8            (I.D0059)
2 RED/YLW FREQ 4                (0067) 15 RED K-TYPE NEG 1
3 WHT/BLU ANALOG 13        (0016) 16 RED K-TYPE NEG 2
4 WHT/VLT ANALOG 14        (0017) 17 RED K-TYPE NEG 3
5 VLT/YEL ANALOG 15        (0050) 18 RED K-TYPE NEG 4
6 WHT/ORG ANALOG 16        (0051) 19 RED K-TYPE NEG 5
7 YEL K-TYPE 1             (0052) 20 RED K-TYPE NEG 6
8 YEL K-TYPE 2             (0053) 21 RED K-TYPE NEG 7
9 YEL K-TYPE 3             (0054) 22 RED K-TYPE NEG 8
10 YEL K-TYPE 4             (0055) 23 BLK K-TYPE SHIELDS GRND
11 YEL K-TYPE 5             (0056) 24 N/C
12 YEL K-TYPE 6             (0057) 25 DK GRN SWITCHED OUT 2
13 YEL K-TYPE 7             (0058) 26 N/C FREQ 6         (I.D0069)  LOW

RESOLUTION

#91294 Advanced Thermocouple Harness parts and vendor details  
         

QTY DESCRIPTION MANUFACTURER MANUFACTURER PART
NUMBER

1 26 POSITION SUPER SEAL HOUSING AMP 2-1437285-2

25 SOCKET TERMINAL, SUPER SEAL AMP 3-1447221-5

1 HOUSING, METRI-PACK 150 SERIES DELPHI 12129615

3 TERMINAL, MALE METRI-PACK 150 SERIES DELPHI 12077628

3 CABLE SEAL, METRI-PACK 150 SERIES DELPHI 12048087

1 TPA, METRI-PACK 150 SERIES DELPHI 12052845

8 SUBMINI CONNECTOR ALLOY CODE K OMEGA SMPW-K-F

6 EN3 MINI WEATHERTIGHT CONNECTOR SWITCHCRAFT EN3C4FC
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#91291 Advanced Analog Harness Details
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#91291 Advanced Analog Harness Schematic
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#91291 Advanced Analog Harness LCU Connector pin assignments

26 Pin LCU Connector

PIN WIRE COLOR FUNCTION         (Ch I.D) PIN WIRE COLOR FUNCTION                   (Ch I.D)
1 GRY/BLK FREQ 3               (I.D0066) 14 RED/BLU ANALOG 24 or CARD  (I.D0059)
2 RED/YLW FREQ 4               (I.D0067) 15 N/C
3 WHT/BLU ANALOG 13       (I.D0016) 16 N/C
4 WHT/VLT ANALOG 14       (I.D0017) 17 N/C
5 VLT/YEL ANALOG 15       (I.D0050) 18 N/C
6 WHT/ORG ANALOG 16       (I.D0051) 19 N/C
7 LYLW/BLK ANALOG 17       (I.D0052) 20 N/C
8 LT GRN ANALOG 18       (I.D0053) 21 N/C
9 DK BLU ANALOG 19       (I.D0054) 22 N/C
10 DK GRN/WHT ANALOG 20       (I.D0055) 23 N/C
11 VLT ANALOG 21       (I.D0056) 24 N/C
12 TAN/WHT ANALOG 22       (I.D0057) 25 DK GRN SWITCHED OUT 2
13 WHT/BRN ANALOG 23       (I.D0058) 26 N/C FREQ  6           (I.D0069)  LOW

RESOLUTION

#91291 Advanced Analog Harness parts and vendor details

QTY DESCRIPTION MANUFACTURER MANUFACTURER PART
NUMBER

1 26 POSITION SUPER SEAL HOUSING AMP 2-1437285-2

16 SOCKET TERMINAL, SUPER SEAL AMP 3-1447221-5

1 HOUSING, METRI-PACK 150 SERIES DELPHI 12129615

3 TERMINAL, MALE METRI-PACK 150 SERIES DELPHI 12077628

3 CABLE SEAL, METRI-PACK 150 SERIES DELPHI 12048087

1 TPA, METRI-PACK 150 SERIES DELPHI 12052845

14 EN3 MINI WEATHERTIGHT CONNECTOR SWITCHCRAFT EN3C4FC
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 Basic System Example
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 Advanced Thermocouple System Example
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Instrumentation

All sensors output a voltage that represents a particular measurement; for example a linear potentiometer has

a measurement range of 0-100mm and over this range its output is 0-5 volts.

The logger cannot store these voltages directly, so it converts them into digital information, a process know as

analog to digital conversion (ADC). The logger looks at the voltage from the sensor at regular intervals, known

as the logging rate, and converts the voltage into a binary number or counts(BITS).

When data is downloaded from the logger it creates a file known as a dataset. The dataset contains all of the

samples for every channel that was logged. The computer uses the channel  calibrations to convert this data

into recognized units; for example, inches, deg C/F or psi etc. 

Wiring information for different sensor types is given in the following pages.

Sensor wiring notes:

· Sensor ground is connected to all sensors and is used as a zero reference

· Sensor power +5V is connected to various sensors as required and is used as a voltage reference.

· +12V is connected to various sensors as required and is used as a source voltage. 

· Signal+ and Digital Signal is the sensors 0 to 5 volt signal output to the LCU.

Notes:

· QwikData 2 harness analog sensor connector part number is (switchcraft EN3C4MC)

· QwikData 2 is compatible with first generation QwikData sensors.

· Refer to the QwikData 2 section of the Edelbrock website for a complete listing of QwikData 2 accessories,

part numbers and available sensors. 

· For more detailed information please refer  to  the QwikData  2  Installation  Manual  included with  your  kit  or

refer to Help on the toolbar of your QwikData 2 software.

Exhaust Gas Temperature Sensors

The exhaust gas temperature (EGT) thermocouples are typically mounted in each of the exhaust header pipes

close to the header flange (usually about 3" away). The exact location is not critical but you should try to mount

all  the  EGTs  at  approximately  the  same  location  in  each  header  for  consistent  measurements.  The  EGT

thermocouples  are  supplied  with  a  compression  fitting  similar  to  the  general  purpose  thermocouples.  The

compression fitting consists of four parts; a bung, an adapter, a ferrule, and a compression nut. To install the

EGT thermocouples, you need to drill  a 9/16”  clearance hole in  the exhaust  header and then weld the bung

into the header.

Note: The bung is threaded with a 1/8” NPT and MUST be mounted with the inside taper facing out.

Once the bung has been welded in place, thread the adapter into the bung and tighten. Place the ferrule into

the adapter  and loosely thread the compression nut  onto  the adapter.  Insert  the EGT thermocouple into  the

compression fitting and tighten the compression nut to secure the thermocouple. Insert the EGT thermocouple

into the compression fitting until the tip is approximately in the center of the header. Secure by tightening the

compression nut.
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Wheel / Shaft Speed Sensors

These sensors can be used to measure either wheel speed or shaft speeds. They are supplied with two rare

earth magnets and a sensor pickup. The two magnets are mounted equally spaced around the rotating object

(wheel  or  shaft)  and  the pickup  is  mounted  on  a  stationary  object.  For  proper  operation,  the  magnets  must

pass within a maximum of 1/4 inch of the pickup. Because of this restriction, it is very important to mount the

pickup on something that moves very little relative to the magnets. For example, if the magnets are mounted

on the drive shaft, they should be either mounted close to the transmission end or close to the final drive, and

the  pickup  should  be  mounted  directly  to  the  transmission  or  the  final  drive  respectively.  Similarly,  if  the

magnets  are  mounted  to  a  wheel,  the  pickup  must  be  mounted  to  a  suspension  piece  that  moves  with  the

wheel. The magnets can be epoxied in place. 

Driveshaft sensor kits including sensor mount and driveshaft collar are available from Edelbrock.

· Reed Switch Speed Sensor #91116 purchased before Sept.09 require a .33uF capacitor be soldered across

the signal and ground wires inside the Switchcraft sensor connector.

Calibrations

A calibration is a mathematical equation that can be applied to a sensors output to convert it into engineering

units. The calibration tools of QwikData 2  let you:

· enter a known calibration curve for an analog sensor.

· apply gain and offset calibration functions.

· choose mathematical equations that describe the behaviour of the sensor.

When you choose to graph a channel using the Analysis program the calibration is attached to the raw sensor

data and converts it to engineering units.

Channel Types

There are four types of channels defined:

· physical analog sensor channels

· internal system channels

· digital channels

· data stream channels

Each channel is defined by a set of parameters that the logger uses to allocate memory space in the logging

table. A hardware index is used to refer to the physical connection between each sensor and the logger. Each

analog or digital channel connects to the logger through its connector in the LCU harness..

Data stream channels such as those received by a communication link to an ECU connected to the logger via

a  communications  port.  These  channels  do  not  have  physical  location  but  have  a  hardware  index  which  is

defined by the database generated for each manufacturers ECU.
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Connecting a Pressure Transducer

Connect 0-5volt output sensor (e.g. pressure transducer) to a analog input as shown below. Use Either the 5v

or 12v excitation voltage as recommended by the sensor manufacturer. 5v excitation shown below.

NOTE: Only 0-5 Volt signals can be used. No 0-10 Volt or 0-12 Volt.

Connecting a Potentiometer

Connect a potentiometer sensor to a analog input as shown below.

Connecting a Wide Band Lambda Sensor

Most  Wideband  controllers  have  an  analog  output  signal  (0-5v)  used  for  data  logging  or  connecting  to  an

engine  management  system.  Connect  this  wire  to  pin  #2  of  the  Analog  Connector  for  the  channel  you  are

configuring. If a output signal ground is supplied follow manufacturers installation instructions.
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Connecting a Thermistor Sensor

Connect a RTD Thermistor sensor to an analog input as shown below. 

· Channels #7,8,9, and 10 are configured for Thermistor Temperature Sensor inputs.

Connecting a Reed Switch Speed Sensor

Connect Wheel/Shaft Speed Sensor #91116 as shown below.

     

· Reed Switch Speed Sensor #91116 purchased before Sept.09 require a .33uF capacitor be soldered

across the signal and ground wires inside the Switchcraft sensor connector.

Note: QwikData 2 only accepts Reed Switch Speed Sensors or Hall Effect Type Speed Sensors.

Connecting a Tach Input

Digital  Channel  inputs  can  be configured  to  receive  a  tach  signal  for  a  RPM input.  Most  electronic  ignitions

provide a tach output. This wire should be connected to the Tach Input wire(Digital 1) on your Basic Harness.

WARNING!!!: THIS INPUT MUST NOT BE CONNECTED DIRECTLY TO THE IGNITION COIL.
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Pre Outing Check-List

Use the following information when preparing your race car for a event to help verify your car is properly setup

for each session.

1. Open the Configuration program

2. Set Current Car for setup. (ex. Car 01)

3. Register LCU. Specify Car Setup file and download path. 

4. Calibrate sensors as necessary if any sensor changes have been made.

5. Verify Logging Table settings, channels for logging, channel sample rates and enable criteria.

6.  Update Outing data file with driver and comments information.

7.  Update Setup Sheet sheet.

8.  Open USB Communication program.

9.  Open a Template (**.nsb) if the preferred channel monitoring screen is not displayed.

10.  Update Session Data information.

11. Send Config to Logger.

12. Zero selected Channels if necessary.

13. Verify sensor functions and channel values.

14. Manually Start Logger from Syscon option and log sample data to test setup.

15. Stop data logging and Download sample data file.

16. Open Data Analysis program.

17. Select Replace Outing and verify logged data.
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QwikData 2 Tech Support

For further information, Technical support, updates and free downloads please see the Edelbrock web site and

QwikData 2 Support Forum: 

Edelbrock Toll-Free Tech Line: 800-416 8628
7am-5pm PST, Monday-Friday

Web site: 
Edelbrock.com - Automotive - Data Acquisition- QwikData 2

Edelbrock Forum: QwikData 2

Edelbrock Corporation
2700 California St
Torrance CA. 90503
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